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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

CAUTION  
indicates that minor personal injury can result if proper precautions are not taken. 

NOTICE  
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Introduction 2
 

COMOS data and documents are increasingly needed by people on the move. Reviews are 
needed while out and about or data is required on site at plants. COMOS Web is a server-
based Internet interface to COMOS which permits this kind of mobile access. 

There are three products available to you for the different mobile scenarios: 

COMOS Web 
COMOS Web lets you use Internet Explorer to log onto a COMOS database. You then have 
browser-based read-only access to COMOS data. This means that data is displayed, but you 
cannot edit it. You cannot change general COMOS settings via COMOS Web. 

COMOS Web displays the following data: 

● Revised documents in PDF format 

● External documents, also without revisions 

● Last checked version of DVM documents 

● Queries 

● Engineering data in the Navigator 

● Attributes of the engineering objects 

The following functions are available: 

● Navigation 

● Full text search of external documents, DVM documents and revised documents 

● Language selection for the user interface and database 

See also chapter Working with COMOS Web (Page 9). 

COMOS SharePoint interface 
Via COMOS DocumentView of the COMOS SharePoint Interface you can provide access to 
COMOS documents within your normal SharePoint environment. All you need for access is 
the corresponding entitlement of the respective user in SharePoint. Entering every single 
user into the COMOS database is not necessary. No documents are duplicated. Instead, 
documents are made available via COMOS DocumentView directly from COMOS in 
SharePoint 

COMOS DocumentView can be individually configured per SharePoint site. In this case it 
can be determined for all projects from which document group a COMOS database 
document has been offered. The following documents can be opened and downloaded: 

● Revised documents in PDF format 

● External documents, also without revisions 

● All versions of DVM documents 
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See also chapter Working with COMOS DocumentView (Page 31). 

"COMOS Mobile Document Review" 
The "COMOS Mobile Document Review" iPad app enables mobile access to and review of 
relevant documents even without COMOS experience. You send revised COMOS 
documents from COMOS to users of "COMOS Mobile Document Review". In "COMOS 
Mobile Document Review", you download the documents so that they are also available 
offline. This enables you to see which documents are new and you have the option of 
identifying selected documents as favorites. You can save a review to a PDF document with 
identified errors and added comments. You save this red-lining and then send it via E-mail or 
back to COMOS. This means that you do not change the actual COMOS data or documents. 
Rather you overlay your comments onto the existing PDF. 

See also chapter Working with "COMOS Mobile Document Review" (Page 33). 
 

 Note 
Compatibility not guaranteed 

The Web services of COMOS Web are not designed as API or for the development of 
customer-specific solutions; they are only intended for use by the specific clients. In 
particular, there is no compatibility guarantee for the Web services. 
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Working with COMOS Web 3
3.1 Requirements 

Basic knowledge 
You should have basic knowledge of the operation of COMOS. For more information on the 
basic terminology and modes of operation in COMOS, refer to COMOS Platform Getting 
Started. 

Recommendation 
Use Microsoft Internet Explorer 8.0 or higher. 

Other requirements 
A configured COMOS Web server is available. You know the URL of the Web server. 

See also 
Opening and logging into COMOS Web (Page 10) 

3.2 Changes 

Database 
Changes are only displayed in COMOS Web if you made them directly in the database that 
the Web server is using. Use COMOS for this purpose. 

When data is changed for a project which you are currently accessing with COMOS Web, 
problems may occur during updating in COMOS Web. 
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3.3 Starting and closing COMOS Web 

3.3.1 Opening and logging into COMOS Web 

Procedure 
1. Start the Internet Explorer. 

2. Enter the address of COMOS Web. 

If you are not automatically authenticated, for example, based on your current Windows 
account, you are prompted to enter a user name and password in a standard browser 
window. When specifying the user name, also enter the domain name, depending on the 
configuration at the server end. Therefore, enter either "User name" or "Domain\User 
name". 

The login window for COMOS Web is displayed. 

3. Enter the required logon details in the relevant boxes. 

4. Click the "Login" button. 

Result 
You are logged into COMOS Web. 

Security note 
User name and password are usually discarded only after the browser is closed, and they 
may also be saved between browser sessions, depending on the browser settings. For 
security reasons, do not store the data on publicly accessible computers, especially if you do 
not control the browser settings yourself. 

See also 
Control elements during login  (Page 53) 

Closing COMOS Web (Page 11) 
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3.3.2 Closing COMOS Web 

Requirement 
You are logged into COMOS Web. 

Procedure 
To close COMOS Web, click "Log out". 

Result 
You are logged out. The logon window is displayed. 

Security note 
See also chapter Opening and logging into COMOS Web (Page 10). 
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3.4 Projects and working layers 

3.4.1 Opening a project 

Procedure 
To open a project, proceed as follows: 

1. Start COMOS Web and log in. 

The projects are listed in the "Open project" area. 

2. Select the desired project in the "Open project" area. 

The name of the selected project is displayed in the "Project" field. 

 
3. Click the "Open" button. 

Result 
The selected project is opened. 

See also 
Opening and logging into COMOS Web (Page 10) 

Displaying projects and working layers (Page 53) 
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3.4.2 Opening a working layer 
Only working layers of a defined level are displayed. The administrator defines the level in 
the "Comos.Web.config.xml" file. See also chapter Configuring "Comos.Web.config.xml" 
(Page 37). 

Procedure 
1. Log into COMOS Web. 

The projects are listed in the "Open project" area. 

2. Select the desired project in the "Open project" area. 

The "Working layer" area lists the working layers of the selected project and the defined 
level. 

3. Select the desired working layer from the "Working layer" area. 

The names of the selected project and working layer are displayed in the "Project" field. 

4. Click the "Open" button. 

Result 
The selected working layer is opened. 

See also 
Displaying projects and working layers (Page 53) 

3.4.3 Switching the project or working layer 

Requirement 
You have already opened a project or working layer. 

Procedure 
To switch to a different project or working layer, proceed as follows: 

1. Click the "Start > Open project" menu. 

The "Open project" and "Working layer" areas are displayed. 

2. Select one of the following options: 

– If you want to open a different project, select it from the "Open project" area. 

– If you want to open a different working layer, select the project from the "Open project" 
area and the working layer from the "Working layer" area. 

3. Click the "Open" button. 



Working with COMOS Web  
3.4 Projects and working layers 

 COMOS Web 
14 Operating Manual, 09/2012, A5E03775687-03 

Result 
The corresponding project or working layer is opened. 

See also 
Displaying projects and working layers (Page 53) 

3.4.4 Switching the project language 
You determine the language in which the COMOS Web user interface is displayed when you 
log in. When you have opened a project, you can choose the language in which it is 
displayed. 

Requirement 
You have opened a project or working layer in COMOS Web. 

Procedure 
To switch the language of the open project, proceed as follows: 

1. Click the "Languages" menu. 

2. Select the desired language. 

Result 
The open project is displayed in the relevant language. 

If updating problems occur, open the project again. 

See also 
Control elements during login  (Page 53) 
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3.5 Navigator 

Views 
When you have opened a project or working layer, the Navigator is automatically displayed 
in the "Units" view.  

You can configure the following views for the Navigator: 

● "Units" 

● "Locations" 

● "Documents" 

See also 
Configuring the Navigator view (Page 15) 

3.5.1 Configuring the Navigator view 

Procedure 
To switch the Navigator view, proceed as follows: 

1. Click the "View" menu. 

2. Select the desired view using the corresponding command. 

Result 
The Navigator is displayed in the relevant view. The marker on the "View" menu indicates 
which view is currently set. 

Example 
In the following example the "Units" view is set. 
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3.5.2 Navigator display 

Overview 
The open project is always displayed at the top in the Navigator. Beneath it the objects 
belonging to the engineering project in question are displayed.  

System types 
Objects of the following system types are displayed in the Navigator: 

● "Device" 

● "Document" 

3.5.3 Basic operation of the Navigator 

3.5.3.1 Using the Navigator 

Selection 
To select an object in the Navigator, click on the object. 

Navigation 
To expand the Navigator tree structure, click "+". To collapse the Navigator tree structure, 
click "-". 

Navigation using the keyboard 
You can use the arrow keys to navigate in the tree structure. The following table describes 
the functions of the arrow keys: 

 
Key Description 
<Up arrow> Selects the next object up in the Navigator. 
<Down arrow> Selects the next object down in the Navigator. 
<Right arrow> Expands the tree structure. 
<Left arrow> Collapses the tree structure. 
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3.5.3.2 Opening an object 

Requirement 
You have opened a project or working layer. 

Procedure 
To open an object, double-click on it in the Navigator. 

Result 
A main window with the object-specific display is opened: 

● Queries are displayed in a special query window. 

● COMOS documents are only displayed if they have been revised. If there is no revision 
for the document you want to open, an error message is displayed. 

● The properties of all other objects are opened. In the properties the various tabs of the 
object and their attributes are displayed. 

See also 
Queries (Page 22) 

Documents (Page 25) 

The properties (Page 21) 

3.5.3.3 Closing an open object 

Requirement 
You have opened an object. 

Procedure 
To close open objects, click the  button at the top right. 

Result 
The opened object is closed. 
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3.5.3.4 Navigating to documents on which an engineering object is placed 

Procedure 
To navigate from the Navigator to a document on which an engineering object is placed, 
proceed as follows: 

1. Select an engineering object in the Navigator. 

2. Right-click on the selected object. 

3. Click the "Documents > <Name of document>" command in the context menu. 

Result 
The corresponding document is automatically selected in the Navigator. 

3.5.3.5 Navigating to the location in the Units Navigator 

Requirement 
The Navigator is displayed in the "Units" view. 

Procedure 
To navigate to the location in the Units Navigator, proceed as follows: 

1. Select the desired object in the Navigator. 

2. Right-click on the selected object. 

3. Click the "Location: <Name of location>" command in the context menu. 

Result 
In the Navigator the location is selected to which the selected object has a link. 
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3.5.3.6 Navigating to the unit in the Documents Navigator 

Requirement 
The Navigator is displayed in the "Document" view. 

Procedure 
To navigate to the unit in the Documents Navigator, proceed as follows: 

1. Select the desired object in the Navigator. 

2. Right-click on the selected object. 

3. Click the "Unit <Name of unit>" command in the context menu. 

Result 
In the Navigator the unit is selected to which the selected object has a link. 

3.5.3.7 Navigating to the implementation 

Procedure 
To navigate to the implementation, proceed as follows: 

1. Select the desired object in the Navigator. 

2. Right-click on the selected object. 

3. Click the "Implementation" command in the context menu. 

Result 
In the Navigator the object to which the selected object has an implementation link is 
selected. 
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3.5.3.8 Navigating to the original document 

Requirement 
The Navigator is displayed in the "Document" view. 

Procedure 
To navigate to the original document, proceed as follows: 

1. Select the desired document in the Navigator. 

2. Right-click on the selected document. 

3. Click the "Original document > <Name of document>" command in the context menu. 

Result 
The original document is selected in the Navigator. 
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3.6 The properties 

Attributes and tabs 
Tabs group the object attributes. The attributes describe the object. 

To open a tab, click on it. You can only view the attributes that are displayed in the tabs in 
COMOS Web, not edit them. 

Display 
The properties are always displayed to the right of the Navigator. An information bar is 
displayed at the top. 

 
The information bar contains the following information: 

● Type of object selected: 

– Object 

– Document 

– Query 

● FullLabel of the selected object 

● Description of the selected object 

Scrolling 
Next to the tabs you see the following buttons: 
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You can use these buttons to scroll through the tabs so as to view the headers of the tabs 
which cannot be fully displayed. 

3.7 Queries 

3.7.1 General 

Overview 
When a query has been saved in the Navigator under the base object "@System > @O > 
@Web > @Query", you can open this query in COMOS Web. However, you cannot edit the 
query or create new queries. See also chapter Creating a base object for queries in COMOS 
(Page 43). 

3.7.2 Opening a query 

Requirement 
A query has been stored in the COMOS Navigator. You see this query in the COMOS Web 
Navigator. 

Procedure 
To call a query, double-click on it in the Navigator. 

Result 
The query is displayed in the main window.  

See also 
Displaying a query in an own area (Page 23) 
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3.7.3 Displaying query properties 

Requirement 
A query has been stored in the COMOS Navigator. You see this query in the COMOS Web 
Navigator. 

Procedure 
To open the attributes of a query, proceed as follows: 

1. Select the query in the Navigator. 

2. Right-click on the selected query. 

3. Select the "Properties" command in the context menu. 

Result 
The properties of the query are displayed in the main window. 

See also 
The properties (Page 21) 

3.7.4 Displaying a query in an own area 

Procedure 
To display the query in a dedicated area, proceed as follows: 

1. Open a query. 

The query is displayed in the COMOS Web main window. 

2. Click the  button. 

Result 
The query is displayed below the Navigator in an own area. This enables you to open 
another object in the main window. 
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3.7.5 Navigating from the query to the Navigator 

Requirement 
You have opened a query. 

Procedure 
To navigate from the query into the Navigator, proceed as follows: 

1. Select an entry from the open query. 

2. Right-click on the selected entry. 

3. Select the "Navigate to object" command in the context menu. 

Result 
The object is selected in the Navigator. 

3.7.6 Opening the properties of an object from the query 

Requirement 
You have opened a query. 

Procedure 
To open the properties of an object from a query, double-click on an entry in the query. 

Result 
The properties of the object are displayed in the main window. If you previously opened the 
query in the main window, it is closed. If the query contains documents, the last revision of 
the document is opened. 

See also 
The properties (Page 21) 

Displaying a query in an own area (Page 23) 
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3.8 Documents 

3.8.1 Document types 

Overview 
The following document types exist: 

● Reports 

● External documents 

● PQM documents. 

Display of PDF documents 
You need to use Adobe Reader version 7.0 or higher to view PDF documents – and thus 
also revisions – in COMOS Web.  

See also 
Reports (Page 26) 

Opening external documents (Page 28) 

Display of PQM documents (Page 28) 

3.8.2 Opening a document 

Requirement 
A document has been stored in the COMOS Navigator. You see this document in the 
COMOS Web Navigator. 

Procedure 
To open a document, double-click on it in the Navigator. 

Result 
The document is opened.  

See also 
Open the properties of a document (Page 26) 
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3.8.3 Open the properties of a document 

Requirement 
A document has been stored in the COMOS Navigator. You see this document in the 
COMOS Web Navigator. 

Procedure 
To open the properties of a document, proceed as follows: 

1. Select the desired document in the Navigator. 

2. Right-click on the selected document. 

3. Select the "Properties" command in the context menu. 

Result 
The properties of the document are displayed. 

See also 
The properties (Page 21) 

3.8.4 Reports 

Revisions 
A report is only displayed in COMOS Web if a revision of the report is available. When you 
open a report, the revision is always displayed.  

If you try to open a report that has no recently released revision, a relevant error message is 
displayed. 

Displaying the revision 
When you open a report, the last released revision is always displayed. However, you also 
have the option to display older revision states. 

See also 
Opening a document (Page 25) 

Viewing older revision states (Page 27) 
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3.8.5 Viewing older revision states 

Requirement 
You have opened a report. 

Procedure 
To view older revisions of a report, proceed as follows: 

1. Click the  button. 

The revision list is displayed. This list displays all available revisions of the opened report. 

 
2. Click on an entry in the revision list. 

Result 
The report is displayed below the revision list in the selected revision state. 

See also 
Revision list columns (Page 54) 

Hiding the revision list (Page 27) 

3.8.6 Hiding the revision list 

Requirement 
The revision list is displayed. 

Procedure 

To hide the revision list, click the  button. 
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3.8.7 Opening external documents 

Documents with revision 
When you open an external document for which there is a revision, the revision is displayed 
in COMOS Web. 

Documents without revision 
When you open an external document for which no revision exists, the document is 
displayed embedded in Internet Explorer. This applies only to the following external 
documents: 

● Word documents 

● Excel documents 

● PDF documents 

You can read the opened documents but not edit them. However, you can save opened 
external documents. 

Requirement 
Your workstation must be equipped with the appropriate programs in order to open external 
documents without revisions in COMOS Web. If you can display external documents in local 
operation, those documents are also opened in COMOS Web. 

If this function is not available, check the security settings of the Internet Explorer. In order to 
use this functionality, the COMOS Web server popups have to be enabled. 

See also 
Opening a document (Page 25) 

3.8.8 Display of PQM documents 

Display 
When you open a PQM document in COMOS Web, the latest version of it is always 
displayed. You cannot edit opened PQM documents in COMOS, but you can save them.  
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3.9 Document search 

Searching 
Document search is a full-text search function across all documents of the opened project. 
Document search searches through the contents and attributes of all external documents, 
PQM documents and revised reports. 

See also 
Searching for documents (Page 29) 

Full-text search (Page 30) 

3.9.1 Searching for documents 

Requirement 
The search function only works if a search index has been created for the open project. The 
search index must be created in COMOS. You cannot create a search index in COMOS 
Web. 

Procedure 
To search for documents, proceed as follows: 

1. Enter a search key in the box at the top right corner of COMOS Web. 

 
2. To start the search, click the  button. 

Result 
The search results are displayed in the "Search results" area below the Navigator. To open a 
document, or its last released revision, from the results list, double-click on the desired entry. 

If no results are found relating to the term your entered, you see the following message:  

"No search results" 
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3.9.2 Full-text search 

3.9.2.1 Using the Full-text search 

Procedure 
To use Full-text search, proceed as follows: 

1. Click the  button. 

The "Full-text search" area is displayed. 

2. Select the search method from the list at the top. 

 
3. Enter the required information on the "Search" tab. 

Which controls are displayed on the "Search" tab depends on the search mode you 
chose. 

4. Make the necessary search settings on the "Options" tab. 

5. Click the "Search" button. 

Result 
The search results are displayed in the "Search results" area below the Navigator. To open a 
document from the result list, double-click on the entry in question. 

If no results are found relating to the term your entered, you see the following message:  

"No search results" 

See also 
Full-text search user interface reference (Page 54) 

3.9.2.2 Different full-text search methods 

Attributed search and standard search 
A basic distinction is made between standard search and attributed search. Standard search 
is the default. You can create the attributed search in COMOS yourself. For more information 
on this subject, refer to the "Document Management" manual, keyword "Attributed search". 

The "Revisions search", which you can select in the COMOS Web full-text search function, is 
also an attributed search. 
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Working with COMOS DocumentView 4
Requirement 

● The COMOS Web Server, including the current version of COMOS, is set up. 

● If you wish to display external documents, a corresponding program must be installed on 
the computer. 

Document display options 
Open the link to COMOS DocumentView.  

If you are not automatically authenticated on the basis of your current Windows account, you 
will be asked for your username and password in a standard browser window. Enter your 
login details in this case. 

 

 Note 
Account 

The account with which you log onto COMOS DocumentView must be identical to the 
account with which you are currently logged into SharePoint. 

 

 Note 
Security note 

Username and password are not generally discarded until after the browser is closed and, 
depending on the browser setting, are also saved between browser sessions. Do not save 
the data on publicly accessible computers for security reasons, particularly if you are not 
able to control the browser settings. 

 

● Select a document group to list associated documents. 

The projects and documents selected by the responsible administrator are displayed. 

● Click on a document to display details for that document. 

The revisions of a document are shown in the details. For DVM documents, a version 
history is additionally shown. 

● To open a document, click on the name of the document. 

  Note 
Opening reports 

To be able to open a report, it must have been revised beforehand. 
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● To open a specific revision or version of a document, click on the relevant link in the 
details. 

● To quit COMOS DocumentView click on the "Close" button. 

  Note 
Close DocumentView 

Click on the "Close" button to release the license you have been using. If you end 
COMOS DocumentView by closing the browser window directly, the license will only be 
released following a timeout. 

See also 
COMOS SharePoint interface (Page 43) 
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Working with "COMOS Mobile Document Review" 5
Additional information 

You will find more detailed information on this topic in the "COMOS Mobile Document 
Review" manual. 

See also 
"COMOS Mobile Document Review" iPad app (Page 49) 
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Administration 6
6.1 Requirements for operating COMOS Web 

6.1.1 Server-side requirements 

Overview 
To be able to use COMOS Web, the following requirements must be met at the server end: 

● You are using Windows Server 2008 R2. 

● You are using IIS 7 Web server. 

● .NET Framework 4.0 is installed in addition to the standard .NET Framework 3.5 SP2. 
The Frameworks are supplied as standard with the COMOS installation. 

● COMOS is installed on the server. 

● Make sure that the desired port is released on the server for COMOS Web. 

● The user under whom the IIS application pool runs must have read and write access to 
the COMOS document directory. 

  Note 
Using UNC address 

Use the UNC address to address the document directory of the database.  

Correct: \\<Servername>\<COMOS-Dokumentenverzeichnis>  
False: O:\<COMOS-Dokumentenverzeichnis> 

● The user under whom the IIS application pool runs must have access to the COMOS 
database. 

COMOS license  
If you wish to work with COMOS Web, you need a license server from the setup of the 
current COMOS version. You cannot use COMOS Web with local licenses. 

Note 
COMOS Web stores temporary files, such as icons, in the temporary directory of the user 
under whom the IIS application pool is running. 
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6.1.2 Workstation requirements 

Overview 
To be able to use COMOS Web, make sure that Internet Explorer is installed on the 
workstation. Internet Explorer as of version 8.0 is approved for use. 

The user of COMOS Web must be a Windows user who is registered in the COMOS 
database. 

6.2 Installation and configuration 

6.2.1 Configuring Windows Server 2008 R2 

Procedure 
You can use the "Server Manager" tool to manage roles on Windows Server 2008 R2. The 
roles "Application server" and "Web server" must be installed. In turn, the role services listed 
below must be installed for the roles: 

Role services for the "Application Server" 
 
Role service 
.NET Framework 3.5.1 
Web Server (IIS) Support 
Windows Process Activation Service Support 
 HTTP activation 

Role services for the "Web server (IIS)" 
 
Role service 
Web server 

 General HTTP features 
– Static content 
– Standard document 
– Directory search 
– HTTP error 
– HTTP redirect 
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Role service 

 Application development 
– ASP.NET 
– .NET extensibility 
– ISAPI extensions 
– ISAPI filter 

 Integrity and diagnostics 
– HTTP logging 
– Logging tools 
– Request monitor 
– Tracing 

 Security 
– Standard authentication 
– Windows authentication 
– Digest authentication 
– Client certificate assignment authentication 
– IIS client certificate assignment authentication 
– URL authentication 
– Request filtering 
– IP and domain restrictions 

 Performance 
– Compression of static contents 
– Compression of dynamic contents 

Management programs 

 IIS management console 

 IIS management scripts and tools 

 Management service 

6.2.2 Configuring "Comos.Web.config.xml" 

Requirement 
The latest COMOS version is installed. 

You have administrator rights for COMOS and Windows. 

Procedure 
1. Open the "Config" folder in the COMOS installation directory. 

2. Open the "Comos.Web.config.xml" file. 
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3. In the "<Languages>" node, you can see the COMOS user interface languages that are 
offered when you log into COMOS Web. Comment out unwanted "<Language>" type 
elements. 

4. In the "<Databases>" element, define the databases that the user can select when 
logging into COMOS Web. Create a "<Database>" element for each database. 

5. Create the following elements in the "<Database>" element: 

 

Element Description 
<Key> This is a unique identifier used by COMOS Web to reference the database 

specified in the <Connection> element. Use only numbers and Latin letters for 
the identifier. Do not use the same key for different databases; assign a new key 
to each additional database during configuration. 

<Connection> Connection path to the database. Query the path by selecting the "Database 
info ..." command in the "Help" menu of COMOS. 
 Access database example 

C:\Program Files (x86)\Comos\92\Database 9.1.0.2\ComosDB91.mdb 
 SQL database example 

[SQL - SERVER]PT_SQL_SERVER 
 Oracle database example 

[ORACLE]pt_oracle_1 
<Name> Display name of the database in the COMOS Web login interface. 

6. The web service creates actual processes, each of which manages a COMOS workset. 
You can optionally specify in the "<PoolSize>" node how many processes can run at a 
given time. 

It is reasonable to allow as many processes as the server has cores. 

If you do not use this element, COMOS Web automatically selects a value based on the 
system properties of the computer. 

7. Optionally, you define in the "<OverlayLevel>" element the level of the working layers that 
are displayed in the user interface of COMOS Web when projects or working layers are 
opened. 

The default value is "0". This corresponds to working layers which lie directly below the 
released area. 

8. Save your changes. 

See also 
Setting up IIS (Page 40) 

Example for "Comos.Web.config.xml" (Page 39) 
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6.2.3 Example for "Comos.Web.config.xml" 
<?xml version="1.0" encoding="utf-8" ?> 
<Configuration> 
  <Login> 
    <Databases> 
      <!--SQL--> 
      <!--<Database> 
        <Key>db1</Key> 
        <Name>Database 1</Name> 
        <Connection>[SQL - SERVER]PT_SQL_SERVER</Connection> 
      </Database>--> 
      <!--Oracle--> 
      <!--<Database> 
        <Key>db2</Key> 
        <Name>Database 2</Name> 
        <Connection>[ORACLE]pt_oracle_1</Connection> 
      </Database>--> 
      <!--Access--> 
      <!--<Database> 
        <Key>db3</Key> 
        <Name>Database 3</Name> 
        <Connection>D:\Database\ComosDB92.mdb</Connection> 
      </Database>--> 
    </Databases> 
    <Languages> 
      <!--German--> 
      <Language> 
        <LCID>1031</LCID> 
      </Language> 
      <!--English--> 
      <Language> 
        <LCID>1033</LCID> 
      </Language> 
      <!--French--> 
      <Language> 
        <LCID>1036</LCID> 
      </Language> 
      <!--Chinese--> 
      <Language> 
        <LCID>2052</LCID> 
      </Language> 
    </Languages> 
  </Login> 
  <!--<Worker> 
    <PoolSize>2</PoolSize> 
  </Worker>--> 
  <!--<OverlayLevel>1</OverlayLevel>--> 
</Configuration> 

See also 
Configuring "Comos.Web.config.xml" (Page 37) 
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6.2.4 Setting up IIS 

Requirement 
You have knowledge of working with Microsoft Internet Information Services (IIS) Web 
servers. 

 

 Note 
One COMOS Web application per server computer 

For technical reasons, run only one COMOS Web application per server computer. 
 

Procedure 
1. Start the Internet Information Services (IIS) Manager. 

2. Create a new application pool. 

You can name the application pool as you please. 

3. Select .NET Framework 4.0 as the Framework version. 

Confirm your entries. 

4. Open the expanded properties of the application pool. 

The "Extended Properties" window opens. 

5. Specify an identity. 

The user must fulfill specific requirements. See also chapter Server-side requirements 
(Page 35). 

6. Confirm your entries. 

7. Create a new Website. 

You can name the Website as you please. 

8. Assign the website to the previously newly-created application pool. 

9. Specify the physical path to your Website. 

COMOS Web is subsequently integrated as a separate application. Therefore, the path 
can also lead to an empty dummy directory. 

Alternatively you can configure COMOS Web directly as a website and bypass the 
creation of a separate application. If you configure COMOS Web directly as a website, 
enter the path to the "Web" folder in the COMOS installation directory as the path. 
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10. Specify a link for the website. 

You can use http or https or a combination of the two. If you set up both links, add the 
second link afterwards.  

  Note 
http or https? 

Note that not all components are available via http. In particular, "COMOS Mobile 
Document Review" requires https. COMOS Web and COMOS DocumentView can be 
used both via http and https. https requires the selection of a server-end certificate. See 
also chapter Setting up SSL (Page 42). 

11. Confirm your entries. 

12. If you want to set up a second link, open the website links and add a link. 

13. If you want to set up COMOS Web directly as a website, ignore the following steps for 
creating a separate application. 

– Select "Add Application..." from the context menu of the Website. 

– You can assign any alias. 

The alias represents the path to COMOS Web starting from the Website. 

– Make sure that the application pool is the application pool that was produced 
previously and has been also entered for the website. 
In the "Physical path" field, enter the path to the "Web" folder in the COMOS 
installation directory. 

– Confirm your entries. 

14. Open the authentication settings of the website or the application if you have configured 
COMOS Web as a separate application. 

15. Enable Windows authentication. 

16. Disable all other modes of access. 

17. Set up default authentication for "COMOS Mobile Document Review". See also chapter 
Configuring authentication for "COMOS Mobile Document Review" (Page 49). 
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6.2.5 Setting up SSL 

Requirement 
You have obtained an authenticated certificate from a verification provider and installed it on 
the IIS. 

Procedure 
1. Select "Edit Bindings..." from the context menu of the Website. 

The "Site Binding" window opens. 

2. Click "Add". 

The "Add Site Binding" window opens. 

3. Create a new http binding. 

4. Select the previously installed certificate from the "SSL Certificate" list. 

5. Save your settings. 

Optional 
You can optionally configure the SSL settings of the IIS. This is useful, e.g. if both http and 
https-links are configured at the website level, but only https is allowed at the COMOS Web 
application level. In this case proceed as follows: 

1. Double-click the the "SSL Settings" button on the level of the COMOS Web application. 

2. Activate the "Require SSL" option. 

3. Save your settings. 

6.3 Updating COMOS Web 

Procedure 
1. On the IIS, end the application pool under which COMOS Web is running, for example via 

the IIS Manager. 

2. Make sure that the associated process "w3wp.exe" is ended. 

3. Start a COMOS update via the Update Center. 

4. When the COMOS Update is complete, start the application pool under which COMOS 
Web runs. 
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6.4 Creating a base object for queries in COMOS 

Procedure 
1. Open the base project. 

2. Select the "Base objects" tab in the Navigator. 

3. Create a new base object called "@Web" underneath the "@System > @O" base object. 

4. Create a new base object called "@Query" underneath the "@Web" base object. 

5. Create the required queries underneath the "@Query" base object. 

6.5 COMOS SharePoint interface 

Requirement 
● COMOS Web is installed. See also chapter Installation and configuration (Page 36). 

● You are using SharePoint 2010. The following editions are supported: 

– Foundation 

– Standard 

– Enterprise 

● COMOS DocumentView is activated in SharePoint. See also chapter Configuring 
COMOS SharePoint interface at farm level (Page 47). 

 

 Note 
Installation of COMOS Web and SharePoint 

COMOS Web and SharePoint together with the SharePoint interface must be installed in the 
same Windows domain or on the same computer. 

 

Overview 
COMOS SharePoint Interface and the COMOS DocumentView feature let you view COMOS 
cross-project document groups with revised reports or external documents and their 
properties without individual user rights.  
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6.5.1 Configuring authentication for the COMOS SharePoint interface 

Procedure 
It is not necessary to set the authentication individually, provided that you have carried out 
the authentication at the root level of COMOS Web. See also chapter Setting up IIS 
(Page 40). 

6.5.2 Configuring "Comos.Web.config.xml" for the COMOS SharePoint interface 

Procedure 
1. In the "<SystemUsers>" element, define the users employed by the COMOS SharePoint 

interface. 

You can also define multiple "<SystemUser>" elements here. 

2. Create the following elements within the "<SystemUser>" element: 

 

Element Description 
<SharePoint> A SharePoint Site will be implemented within a 

web application to which is assigned an 
application pool. The application pool in turn 
has a distinct identity. Enter the identity into the 
element which is assigned to the site under 
which the COMOS DocumentView is executed.
For example: Domain\user 
This SharePoint user is considered a trusted 
user by COMOS Web. Internally it is used to 
manage browser sessions. 
Tip: 
You can view the identity which belongs to a 
site and/or a web application in SharePoint via 
the following page:  
"Central administration > Security > Configure 
service accounts" 

<Comos> The COMOS user is the user under whom the 
SharePoint interface accesses the COMOS 
database if the browser session was initiated by 
the SharePoint account specified in the 
"<SharePoint>" element. The COMOS user 
requires read access to the COMOS 
DocumentView profiles and to the document 
groups displayed in COMOS DocumentView. 
Example: Domain\user 

3. Save your changes. 
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Example 
<?xml version="1.0" encoding="utf-8" ?> 
<Configuration> 
  <Login>... 
  <Worker>... 
  <SharePoint> 
    <SystemUsers> 
      <SystemUser> 
        <SharePoint>domain\sharePointUser</SharePoint> 
        <Comos>domain\comosUser</Comos> 
      </SystemUser> 
    </SystemUsers> 
  </SharePoint> 
</Configuration> 

6.5.3 Configuring profiles for the COMOS SharePoint interface 

Requirement 
You have write access to the released area of the base project in the COMOS database. 

Procedure 
1. Open the released area of the base project. 

  Note 
Profiles only in released area 

A COMOS database can contain multiple base projects, which may in turn contain 
working layers. COMOS only searches for COMOS DocumentView profiles in the 
released area of base projects, not in working layers. 

2. Create an object for each profile under the node "@System > @O > @Web > @SP > 
@DV > @PF". 

3. Enter a name and description for the object. 

You can freely choose the name and description of the object. 

4. Create the "NOD" tab in the properties of the profile. 

You will find a prepared tab in base objects under "@10 > WEB > 2> WEB050> 01 > 
WEB050". 

5. Create link attributes with any names on the tab. 

Use one link attribute for each document group to be displayed in COMOS 
DocumentView. 

6. Switch to the released area of the project whose document groups you would like to use 
in COMOS DocumentView. 
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7. Drag&drop the document group into the detail area of the Navigator. If the details area is 
not open, drag the document group into the area below the Navigator. 

A new tab is created. 

8. Go to the released area of the base project. 

9. Open the properties of the profile. 

10. Drag&drop the document group from the Navigator into a link attribute. 

  Note 
Document groups 

Only use document groups from the released area. Other document groups are not 
supported. 

11. Repeat steps 6 to 10 for all document groups that you want to use in COMOS 
DocumentView. 

6.5.4 Installing COMOS SharePoint interface on SharePoint 

Precondition 
The COMOS Web Server including the current version of COMOS is set up. See also 
chapter Installation and configuration (Page 36). 

Procedure 
1. Install the file "Comos.Spif.wsp", e.g. via the command rows and the "stsadm" application 

from SharePoint. 

2. Use the following parameters: 
"%CommonProgramFiles%\Microsoft Shared\Web Server 
Extensions\14\BIN\stsadm" -o addsolution -filename Comos.Spif.wsp 
"%CommonProgramFiles%\Microsoft Shared\Web Server 
Extensions\14\BIN\stsadm" -o deploysolution -name Comos.Spif.wsp -
local -allowgacdeployment 
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6.5.5 Configuring COMOS SharePoint interface at farm level 

Procedure 
1. In SharePoint at farm level, open the menu "Central Administration > System Settings > 

Manage Farm Features". 

The existing features are listed. 

2. To activate the COMOS SharePoint interface, click "Activate". 

The "Active" status is displayed. 

3. Open the menu "Central Administration > General Application Settings > COMOS 
SharePoint interface > Basic settings". 

4. In the "COMOS Web Server URLs" field, enter one or several URLs of COMOS Web 
servers. Separate multiple entries with semicolons. 

  Note 
Example of a URL 

Specify the address of the COMOS Web application installed on the IIS without 
subfolders. 

http://<server name>/<name of the COMOS Web application> 

Wrong: 

http://server/comosweb/SharePoint.DocumentView 

Correct: 

http://server/comosweb 

5. In the "Released sites/administrators" enter administrators who can configure the 
COMOS SharePoint interface at the site level. 

Only those administrators entered here are permitted to manage the feature on their site. 

See also 
Configuring COMOS DocumentView at site level (Page 48) 
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6.5.6 Configuring COMOS DocumentView at site level 

Requirement 
You are entered as a site administrator at farm level. See also chapter Configuring COMOS 
SharePoint interface at farm level (Page 47). 

Procedure 
1. Open the "Manage Website actions > Website settings> Website actions > Website 

features" menu. 

2. Activate COMOS DocumentView. 

3. Open the "Website actions > Website settings > COMOS SharePoint Interface > COMOS 
DocumentView settings" menu. 

4. Select the COMOS Web server to which COMOS DocumentView is to connect. 

5. Select a COMOS database. 

The number of databases offered is defined by the configuration of the COMOS Web 
server. See also chapter Configuring "Comos.Web.config.xml" (Page 37). 

6. Select a profile. 

The profile defines the document groups which are offered in COMOS DocumentView. 
You configure the profiles in the COMOS database. See also chapter Configuring profiles 
for the COMOS SharePoint interface (Page 45). 

7. Confirm your entries. 

8. You now have the possibility of using the link to COMOS DocumentView and offering it 
on the SharePoint site in the form of a Web Part, for instance. 

Example: 

<SharePointRoot>/_layouts/Comos.Spif.DocumentView/Application.aspx 

6.5.7 Language settings for the COMOS SharePoint interface 
The language of the COMOS SharePoint interface corresponds to the settings in 
SharePoint. 

The standard COMOS languages are supported. If you select a language that is not 
supported, the interface will be displayed in English. 
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6.5.8 Updating COMOS SharePoint interface on SharePoint 

Procedure 
1. Update the COMOS SharePoint interface with a new version of the file "Comos.Spif.wsp" 

by calling up e,g, the program "stsadm" from SharePoint via the input request. 

2. Use the following parameters: 
"%CommonProgramFiles%\Microsoft Shared\Web Server 
Extensions\14\BIN\stsadm" -o upgradesolution -filename 
Comos.Spif.wsp -name Comos.Spif.wsp -local -allowgacdeployment 

6.5.9 Removing COMOS SharePoint interface on SharePoint 

Procedure 
1. Uninstall the COMOS SharePoint interface with a currently installed version of the file 

"Comos.Spif.wsp" by calling up e.g. the program "stsadm" from SharePoint via the input 
request. 

2. Use the following parameters: 
"%CommonProgramFiles%\Microsoft Shared\Web Server 
Extensions\14\BIN\stsadm" -o retractsolution -name Comos.Spif.wsp –
local 
"%CommonProgramFiles%\Microsoft Shared\Web Server 
Extensions\14\BIN\stsadm" -o deletesolution -name Comos.Spif.wsp 

6.6 "COMOS Mobile Document Review" iPad app 

6.6.1 Configuring authentication for "COMOS Mobile Document Review" 

Introduction 
"COMOS Mobile Document Review" requires the default authentication as authentication.  

Procedure 
1. In the IIS Manager, open the authentication settings of the "DocumentsToGo" folder. 

2. Enable default authentication. 

3. Disable all other modes of access. 
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6.6.2 Specifying the default domain 

Procedure 
In the case of standard authentication you can specify a standard domain. 

1. Open the settings for the default authentication. 

2. Specify the desired domain. 

3. Optionally, in the "Area" field, enter a display value for the domain which the user will see 
upon login. 

Result 
The specified default domain will be added automatically to the user name at login. If you do 
not specify a default domain, the user must enter the domain at login.  

Example 
● With domain: 

Domain\user 

● Without domain: 

User 

6.6.3 Create App-User in COMOS 

Precondition 
The"Activate user project" option in your project options on the "Options > Standard" tab in 
the "User/Rights" control group is active.  

Procedure 
1. Create a new user in the USERS project. 

2. Open the properties of the User object. 

3. In the "Initials/Login" field enter the user name with which the user logs onto the 
database. 

Do not use lower case letters. 

4. Enter the required information. 

5. Click on the "Create user" button. 

6. Confirm your entries. 

7. Repeat steps 1 to 6 for each COMOS user wanting to send documents to, or receive 
documents from, the App. 
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6.6.4 Sending COMOS documents to "COMOS Mobile Document Review" 

Requirement 
You and the recipient of the documents have been created in the USERS project as app 
users. See also chapter Create App-User in COMOS (Page 50). Before you can receive 
documents in the app, you need to have successfully logged into COMOS with the app once. 
You can find additional information on this topic in the "COMOS Mobile Document Review" 
manual. 

Procedure 
1. Open the base project. 

2. Use the base object "@03 > @WEB > Doc2Go" as the engineering object in your 
engineering project. 

3. Open the engineering object properties. 

4. Open the "Attributes > Manage" tab. 

5. In the "User" field create a link to your own user from the node "@System > @Profiles > 
<My profile>". 

6. Enter the required recipient in the "Recipient" field. 

7. You have the option to enter text into the "Comment" field which will be shown in the app. 

8. Select one of the following options: 

– Drag&Drop a revised document from the Navigator into the "Document" field. 

– In the "Revision" field, select a revision from the document revision list. 

If you do not select a revision, the latest revision of the document is automatically 
selected. 

9. Click on the "Send" button. 

10. Confirm your entries. 

Result 
All sent and received documents are listed in the "Document output" table.  

The sent and received documents are saved in your user profile under the "collaboration" 
node.  
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When you synchronize the "COMOS Mobile Document Review" app, the documents and 
revisions are displayed in the app. 

 

 Note 
Synchronized times 

Make sure that the time of your web server is synchronized with the time of your iPad. The 
app receives only documents and revisions which have been added since the last 
synchronization. 
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User interface reference 7
7.1 Control elements during login 

Overview 
The following table describes the control elements in the login window: 

 
Control element Description 
"Database" list Select the database which you want to log into from this list. 

This shows the databases which the administrator has stored 
in "Comos.Web.config.xml". 

"Languages" list The languages supported by the COMOS user interface are 
offered in this list. The entries in the list depend on the 
"Comos.Web.config.xml". See also chapter Configuring 
"Comos.Web.config.xml" (Page 37). The COMOS Web user 
interface is displayed in the selected language. 

"Login" button When you click this button, the login data is transferred to the 
server. If your input is correct, you are logged in to COMOS 
Web. 

 

7.2 Displaying projects and working layers 

Projects 
The following table describes the columns for the display of the projects: 

 
Column Description 
"Name" This column displays the names of the listed projects. 
"Description" This column displays the descriptions of the listed projects. 

Working layers 
The following table describes the columns for the display of working layers: 

 
Column Description 
"Name" This column displays the names of the listed working layers. 
"Description" This column displays the descriptions of the listed working layers. 
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7.3 Revision list columns 

Overview 
The following table describes the columns of the revision list: 

 
Column Description 
"Index" This column displays the index of the relevant revision. The higher the 

index number, the newer the revision status of the report. 
"Description" This column displays the description of the relevant revision. 
"Created by" This column shows the date on which the revision was created. The user 

who created the revision is also displayed. 
"Checked by" This column shows the date on which the revision was checked. The user 

who checked the revision is also displayed. 
"Released by" This column shows the date on which the revision was released. The user 

who released the revision is also displayed. 

7.4 Full-text search user interface reference 

7.4.1 Standard search control elements on the "Search" tab 

Overview 
The following table describes the standard search control elements on the "Search" tab: 

 

 
Control element Description 
"Search below" field Enter the node below which you want to search in this field. Select the 

desired node in the Navigator and then click the "..." button. 
"Search key(s)" field Enter one or more terms you want to search for in this field. 
"Start" button Click this button to start the search. 
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7.4.2 Control elements of the "Search" tab 

Overview 
The following table describes the revision search control elements on the "Search" tab: 

 
Control element Description 
"Unit/Location" field Enter the unit or location under which you want to search for revised 

documents in this field. Select the desired node in the Navigator and 
then click the "..." button. 

"Document group" field Enter the document group under which you want to search for 
revised documents in this field. Select the desired node in the 
Navigator and then click the "..." button. 

"Revision index" field Enter the index of the revision you are searching for in this field. 
Button  

 

Click this button to delete the input in the adjacent field. 

Button  

 

Depending on what is entered in the adjacent field, you have the 
following navigation options: 
 To the entered object 
 To the document 
 To documents below 
See also Navigating to documents on which an engineering object is 
placed (Page 18). 

"Revision label" field Enter the label of the revision you are searching for in this field. 
"Revision description" field Enter the description of the revision you are searching for in this 

field. 
"Created by" field Enter the user who created the revision you are searching for in this 

field. 
"Created on" field Enter the date on which the revision you are searching for was 

created in this field. 
"Checked by" field Enter the user who checked the revision you are searching for in this 

field. 
"Checked on" field Enter the date on which the revision you are searching for was 

checked in this field. 
"Released by" field Enter the user who released the revision you are searching for in this 

field. 
"Released on" field Enter the date on which the revision you are searching for was 

released in this field. 
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7.4.3 Full-text search control elements on the "Options" tab 

Overview 
The following table describes the "Options" tab, on which you make settings for full-text 
search: 

 
Control element Description 
"Documents and revisions" option If you select this option, documents as well as PDF 

revisions of the documents are listed as hits. 
"Revisions" option If you select this option, only the revisions of the 

documents are listed as hits. 
"Only current revisions" option If you select this option in addition to the "Revisions" 

option, only the last project version and the last unit 
revision is listed. 

"Documents" option If you select this option, only documents are listed as 
hits. 

"At least one of the character strings" option If you choose this option, hits are displayed at least 
once if one of the indicated words is found in the 
attributes or content.  
This mode is also called "Natural search". The 
different search items are linked with "AND".  
For more information on this subject refer to the 
"Document Management" manual, keyword 
"Operators and wildcards for searching". 

"All character strings" option If you select this option, hits are displayed if the exact 
words are found in the document.  
The different search items are linked with "AND".  
For more information on this subject refer to the 
"Document Management" manual, keyword 
"Operators and wildcards for searching". 

"Boolean search" option If you select this option, the Boolean operators can be 
used in the search. For more information on this 
subject refer to the "Document Management" manual, 
keyword "Operators and wildcards for searching". 

"Fuzzy search" option If you select this option, search items are also found if 
they are spelled wrong.  
Note that the fuzzy search might be slower than a 
normal search.  

"Substring search" option If you select this option, a wildcard character is placed 
at the beginning and the end of the search item so 
that, for example, the word "test" is also found within 
the string "123test item". 
Please note that the substring search is slower than 
the normal search. 

"Exact search" option If you select this option, the search item has to be 
entered exactly as it appears as a complete word. This 
option disables the substring search. 
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Control element Description 
"Maximum value of the displayed hits" list You use this list to define how many lines of hits are 

displayed in the "Search results" area.  
If you select "0" here, or make no entry in the list, the 
number of hits is unlimited. If you limit the number of 
hits, the search will be faster. 

"Show message if more hits are available 
than displayed" option 

If you choose this option and additionally select an 
entry from the "Maximum value of the displayed hits" 
list, a message appears if more results are found 
relating to the search term. 

"In addition offer general search" option If you select this option, the "Additional search key(s)" 
box is displayed. You can enter additional search 
terms in this field. 

"Restore the default" button Click this button to reset your settings to their defaults. 
Button  

 

Click this button to save the settings you make on the 
"Options" tab. 

"Inclusion filter" field Here you see the file formats by which you can 
search. You cannot make any settings of your own in 
this field. 

"Exclusion filter" field Here you see the file formats by which you cannot 
search. You cannot make any settings of your own in 
this field. 

"Index info" field This box contains information on the created index. In 
order for you to conduct a search, an index must have 
been created in COMOS.  
For more information on this subject refer to the 
"Document Management" manual, keyword "Creating 
an index".  
You cannot make any settings in this field.  
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